E911 Response Server 9145
Installation Instructions
Contents

Introduction ................................................................................................................................. 5
  Product Description ................................................................................................................. 6
  Operational Overview ........................................................................................................... 8
  Front Panel Indicators and Switches ................................................................................... 9

Installation ................................................................................................................................. 11
  Installation Overview .......................................................................................................... 11
  Safety Guidelines and General Installation ...................................................................... 12
  Rack Mounting .................................................................................................................... 14
  Connecting to the LAN ........................................................................................................ 19
  Connecting to the PBX PRI-U Port ..................................................................................... 20
  Connecting to the Telco Network PRI-N Port .................................................................... 22
  Configuring the PBX ............................................................................................................ 24
  Configuring the Administration PC ................................................................................... 24
  Reporting Devices .............................................................................................................. 25
  Monitoring and Recording 911 Calls ................................................................................. 27
  Power .................................................................................................................................. 28

Initial Configuration .................................................................................................................. 29
  Joining the Local Domain .................................................................................................. 29
  Remote Monitor Configuration .......................................................................................... 34

System Administration .......................................................................................................... 35
  Using the System Administration Program ...................................................................... 36
  Using the Event Log Viewer ............................................................................................... 53

System Operation ..................................................................................................................... 57
  Overview ............................................................................................................................. 57
  Line Status Indicators ........................................................................................................ 58
  Switches .............................................................................................................................. 60
  Reporting ............................................................................................................................. 61
  Call Monitoring and Recording ........................................................................................ 62

Alarms ........................................................................................................................................ 63
  Overview ............................................................................................................................. 63
  Alarm Records ..................................................................................................................... 63
  File Alarms .......................................................................................................................... 64
  Hardware Alarms ............................................................................................................... 65
  ISDN PRI-U Alarms ............................................................................................................ 66
  ISDN PRI-N Alarms ............................................................................................................. 67
  Status Messages ................................................................................................................ 68
  Alarm Status ....................................................................................................................... 68

Testing ....................................................................................................................................... 69
  Verifying Proper Operation ............................................................................................... 69
  Generating Test Calls ....................................................................................................... 70
Generating Alarms.............................................................................................................. 71
PBX Configuration Testing .............................................................................................. 72

Troubleshooting.............................................................................................................. 73
  Status Indicators ........................................................................................................... 73
  Unable to Connect with Administration PC................................................................. 76
  Reporting Devices Do Not Work................................................................................... 79

Specifications ...................................................................................................................... 83

Service and Warranty ........................................................................................................ 85
  Service ........................................................................................................................... 85
  Teo Product Warranty .................................................................................................... 86

Safety and Regulatory Requirements ................................................................................ 87
  Cautions ......................................................................................................................... 87
  FCC Part 15 .................................................................................................................... 87
  FCC Part 68 .................................................................................................................... 88
  National Electrical Code ............................................................................................... 88

Glossary .............................................................................................................................. 89
Businesses, shared tenant services, college campuses, and other institutions are sometimes distributed geographically among several locations or dispersed over a large area with their telephone extensions linked to a single Private Branch Exchange (PBX) switch. In such a geographic environment, telephone extensions are often not in the same physical location as the PBX. They may be located on different floors, buildings or campuses.

Most telephone systems are configured such that only the main PBX Telephone Number and its location information are sent to emergency services when 911 is dialed. Consequently, the exact physical location of the emergency must be determined by questioning the caller. When the caller does not know or cannot respond, critical time is spent searching for the person in distress when emergency services arrive on the scene.

The Teo E911 Response Server 9145 resolves these issues. The 9145 contains a station data table that has an exact location description for each PBX station set. Every time any PBX phone is used to dial 911, the 9145 ensures that the correct ANI (Automatic Number Identification) is sent to the PSAP 911 Call Taker and then it instantly sends a text message alert to every need-to-know person you want notified about the emergency event. In a true emergency every second counts; your safety staff members, security team, key management personnel, and anyone else instrumental in your Emergency Procedures Plan will be appropriately notified well before the public Emergency Responders arrive. The E911 Response Server 9145 provides audio recording and real-time audio monitoring. Prank 911 call activity will be instantly identified and you will have the opportunity to take corrective action seconds after the prank call is originated. This is also a valuable tool for validating when an abandoned 911 call has occurred.

The E911 Response Server 9145 is designed for long term reliability and nonstop service, even if hardware maintenance is ever required. The system is designed with redundant hot-swappable power supplies and redundant hot-swappable drives that may be replaced while the system remains in a fully operational mode.

The Emergency alert notifications include PC pop-up screen views with both text and graphic presentation containing calling party information, location information, who’s been notified, direction and map information, as well as emergency response procedure documentation, all customizable. Alerts about emergency calls will generate audible attention-getting sound and all recipients will get detailed text and supporting information. The alerting devices can be PC screens, cell phones, pagers, or even alerts via email messaging. Everyone who needs to know will be alerted.
Product Description

E911 Response Server 9145 Typical Installation
**System Features**

The **E911 Response Server 9145** provides Enhanced 911 (E911) connectivity to any PBX capable of supporting an ISDN-PRI connection. The 9145 provides the following features:

- Direct connection to PBX and Telco ISDN-PRI ports with no other interface equipment required.
- Windows PC Administration Program with help to support system configuration and maintenance.
- Internal database to translate/change PBX station numbers to any 10-digit (ANI).
- Supports text messaging cellular telephones, alphanumeric pagers, printers, and PC “pop-up” screens to report 911 call activity and system alarms.
- An internal log file records and date/time stamps call and alarm records.
- Supports LAN access for remote system administration.
- Built in self-test modes and operational monitoring functions.
- Multicolored front panel indicators show system status, call activities and alarms.
- Fuseless (solid state) line protection on all system interfaces.
- Redundant power supplies.
- Redundant drives.
- Two recording ports are supplied with all systems; two additional recording ports can be ordered.
- Up to four monitoring ports can be ordered.
- Installs in a four post server rack (2U rack height).

**System Configurations**

The 9145 E911 Response Server can be purchased in a variety of factory configurations.

- PBX Stations (100 – 60,000, in 100 station increments)
- Ports, up to (6) total:
  - (2 or 4) Recording Ports
  - (0, 2, or 4) Monitor Ports
The 9145 monitors calls that originate from the PBX towards the Telco network. When a 911 call is detected, the 9145 changes or passes through the 911 network-bound callers telephone number (ANI) according to a user programmed database (station table).

The PBX must be programmed to route 911 calls to the ISDN-PRI port that is connected to the 9145. Once a caller using the PBX goes off hook and dials 911, the calling party’s 3- to 10-digit station number is sent to the 9145 via the ISDN-PRI Data Channel (D Channel). This number is then used as the input to the internal station table database to retrieve the translated 10-digit ANI for the caller’s station.

The 10-digit translated ANI is forwarded via the Telco ISDN-PRI D channel toward the 911 network. The ANI is sent to the 911 Call Taker and the Automatic Location Information (ALI) is retrieved from the Telco ALI database using the received ANI. Upon answer of the 911 call, the voice connection is then completed between the PBX caller and the 911 Call Taker.

The 9145 generates a call start record at the time it receives the 911 call from the ISDN-PRI connection. The call start record is recorded in the system’s Log file and, if programmed to do so, the system will report the event to PC Popup Displays and other reporting devices.

When the 911 call ends, the 9145 will generate a call disconnect record that is also logged and reported. The call disconnect record is sent to the reporting devices.

The 9145 also has the ability to “mask” the outgoing caller ID on non-911 calls. If call masking is enabled, the caller ID sent for non-911 calls may be replaced with another local or pilot number. Sensitive areas such as school classrooms may want a pilot number or administration number presented as the caller ID for non-911 calls.
Front Panel Indicators and Switches

The E911 Response Server has two switch and indicator areas on the front panel.

Front Bezel Removal

Press the red lever left to unlatch the front bezel, and then pull the bezel forward to remove. The bezel may be locked (using the included key) to prevent removal.

![Bezel Latch]

Line Status Control Panel

This control panel has indicators for line and internal processor functions, and a self test switch.

![Line Status Control Panel]

**STATUS** – indicates that the processor and software are functioning correctly.

**PRI-U (PBX)** – shows the communication status of the ISDN PRI-U → PBX port.

**PRI-N (CO)** – shows the communication status of the ISDN PRI-N → Central Office port.

**ALARM** – indicates an alarm condition.

**911 CALL IN PROGRESS** – indicates 911 call activity.

**SELF TEST Switch** – initiates a test of the E911 Response Server (page 69).

*Switches 2 – 4 are reserved for factory use only; they should be left in the OFF (down) position.*
Computer/Network Control Panel

The indicators on this panel show the status of the internal computer system and network connections. The power switch and reset button are also located here.

- **Power Failure** – flashing indicates a failure in either of the two power supplies.
- **Overheat/Fan Fail** – flashing indicates a fan failure. Continuously on (not flashing) indicates an overheat condition, which may be caused by cables obstructing the airflow in the system or the ambient room temperature being too warm.
- **NIC 2** – flashing indicates network activity on LAN interface 2.
- **NIC 1** – flashing indicates network activity on LAN interface 1.
- **HDD** – flashing indicates drive activity.
- **Power** – indicates that power is being supplied to the system’s power supply units. This indicator should normally be illuminated when the system is operating.

- **Reset Button** – press to force a reboot of the system.

- **Power Button** – used to apply or remove power from the power supplies to the server system. Turning off system power with this button removes the main power but keeps standby power supplied to the system. Therefore, you must unplug system power cords before servicing.
Installation Overview

Refer to the illustration on page 6 for the typical installation environment. The 9145 is connected between the PBX network and the Telco network and is typically located in the PBX room.

The following steps must be performed before system installation is complete:

1. Mount the 9145 in the rack.
2. Connect the 9145 to the LAN.
3. Connect both the PBX and Telco ISDN-PRI ports to the 9145.
4. Configure the PBX to route calls from a test number (e.g. ‘711’) to the ISDN-PRI port.
5. Configure the Administration PC.
6. Connect and configure desired Reporting Devices.
7. Connect and configure optional monitor ports.
8. Connect AC power.
9. Configure the 9145 to join the network domain.
10. Initiate an administration session between the Administration PC and the 9145.
11. Using the Administration PC, create and send valid Configuration and Station Table data to the 9145.
12. Verify proper operation by observing status indicators and checking for alarms.
13. Using a test number (e.g. ‘711’), place a test call from the PBX to the system.
14. On the Administration PC, use the Log Viewer to verify the correct calling station number and ANI number.
15. Configure the PBX to route 911 calls to the ISDN-PRI port.
16. Dial ‘911’ to place a live test call to the 911 Call Taker.
17. Communicate with the 911 Call Taker to obtain the ANI and verify voice call quality.
18. Connect, configure and test desired Reporting Devices.
19. Connect, configure and test optional monitor ports.
20. Verify PBX Overflow (Alternate Routing) and remote PBX 911 call operation.

To ensure proper operation of the 9145, ALL of the above tasks must be completed before placing the unit into operation. Make sure that the Configuration and Station data is set up correctly prior to sending to the 9145, and perform all tests described in the Testing section.

Ongoing administration must be performed to keep the 9145 configuration current with any changes to the telephone system.

Teo’s liability is limited to replacement of a defective 9145 as stated in the Product Warranty (page 85).
Safety Guidelines and General Installation

Safety Guidelines
Prior to installing the system, read and follow all safety guidelines. The 9145 must be installed only by qualified personnel. The following warnings and cautions must be observed during installation and operation of the system.

**WARNING!**

**RISK OF ELECTRICAL SHOCK!**

Never install telephone wiring during a lightning storm.

Never install telephone jacks in wet locations unless the jack is specifically designed for wet locations.

Never touch uninsulated telephone wires or terminals unless the telephone line has been disconnected at the network interface.

Do not attach or staple the AC power cord to any building surface.

**CAUTION!**

To reduce the risk of fire, use only No. 26 AWG UL Listed or CSA Certified Telecommunications Line Cord for all connections to the telephone network.

**CAUTION!**

This equipment shall be installed only in restricted access areas in accordance with Articles 110-16, 110-17 and 110-18 of the National Electrical Code ANSI/NFPA No. 70–1987 and any local codes as required.
Unpack and Inspect the Equipment

Check the components for damage that might have occurred during shipment. If any equipment is damaged, contact the carrier. Verify that the shipment is complete by comparing the shipped equipment with the shipping list.

The following items are included:

1. E911 Response Server 9145
2. Power cords
3. Brackets for 19" rack mounting
4. Mounting bracket thumbscrews
5. Rack inner rails
6. Rack inner rail extensions
7. Rack inner rail screws
8. Rack long (front) outer rails
9. Rack short (rear) outer rails
10. Front bezel key
11. Installation Instructions (this manual)
12. CD with Administration Program, Event Log Viewer, and Alert Responder software

Location Requirements

The 9145 installation requires a clean, secure room on the customer premises. The room must have adequate ventilation and room for front and rear panel access. The 9145 must only be installed in dedicated equipment rooms or restricted areas when the equipment is mounted to a wall (backboard) or equipment rack, and it must be installed per articles 115-15, 110-17 and 110-18 of the National Electrical Code ANSI/MFPA.

The 9145 must be mounted in a 19" equipment rack.

Environmental Considerations

The 9145 is designed to operate within the following environmental limits:

Operating Temperature: 0° to 40° C (outside the chassis)

Operating Humidity: Up to 95% (non-condensing)
Rack Mounting

⚠ Rack Precautions

- Ensure that the leveling jacks on the bottom of the rack are fully extended to the floor with the full weight of the rack resting on them.
- In single rack installation, stabilizers should be attached to the rack.
- In multiple rack installations, the racks should be coupled together.
- Always make sure the rack is stable before extending a component from the rack.
- You should extend only one component at a time – extending two or more simultaneously may cause the rack to become unstable.
- Determine the placement of each component in the rack before you install the rails.
- Install the heaviest server components on the bottom of the rack first, and then work up.
- Always keep the rack’s front door and all panels and components on the servers closed when not servicing to maintain proper cooling.
- Equipment should be mounted into a rack so that the amount of airflow required for safe operation is not compromised.
- Equipment should be mounted into a rack so that a hazardous condition does not arise due to uneven mechanical loading.
- A reliable ground must be maintained at all times. To ensure this, the rack itself should be grounded. Particular attention should be given to power supply connections other than the direct connections to the branch circuit (i.e. the use of power strips, etc.).
- The 9145 weighs approximately 40 lbs. Make sure that the rack unit is capable of properly supporting this weight.
Mounting Instructions

There are a variety of rack units on the market, which may mean the assembly procedure will differ slightly. You should also refer to the installation instructions that came with the rack unit you are using.

Identifying the Sections of the Rack Rails

Two rack rail assemblies are included in the rack mounting kit. Each assembly consists of two sections: an inner fixed chassis rail that secures directly to the server chassis, and an outer fixed rack rail that secures directly to the rack itself.

Locking Tabs

Both chassis rails have a locking tab. The tabs lock the server into place when installed and pushed fully into the rack. These tabs also lock the server in place when fully extended from the rack. This prevents the server from coming completely out of the rack when you pull it out for servicing.
Installing the Inner Rail Extensions

The SC825 chassis includes a set of inner rails in two sections: inner rails and inner rail extensions. The inner rails are pre-attached. Attach the inner rail extensions to stabilize the chassis within the rack.

1. Place the inner rack extensions on the side of the chassis aligning the hooks of the chassis with the rail extension holes. Make sure the extension faces "outward" just like the pre-attached inner rail.
2. Slide the extension toward the front of the chassis.
3. Secure the chassis with 2 screws as illustrated. Repeat steps for the other inner rail extension.
Installing the Outer Rails to the Rack

Outer rails attach to the server rack and hold the server in place. The outer rails extend between 30 inches and 33 inches.

1. Attach the short bracket to the outside of the long bracket. You must align the pins with the slides. Also, both bracket ends must face the same direction.

2. Adjust both the short and long brackets to the proper distance so that the rail fits snugly into the rack.

3. Secure the long bracket to the front side of the outer rail with two M5 screws and the short bracket to the rear side of the outer rail with three M5 screws.

4. Repeat steps 1-4 for the left outer rail.
Installing the Chassis into a Rack

1. Confirm that chassis includes the inner rails (A) and rail extensions (B). Also, confirm that the outer rails (C) are installed on the rack.

2. Line chassis rails (A and B) with the front of the rack rails (C).

3. Slide the chassis rails into the rack rails, keeping the pressure even on both sides (you may have to depress the locking tabs when inserting). When the server has been pushed completely into the rack, you should hear the locking tabs "click".

4. (Optional) Insert and tighten the thumbscrews that hold the front of the server to the rack.
Connecting to the LAN

Connect one of the LAN ports on the 9145 to the LAN using a Category 5 network cable. Two LAN ports are provided on the 9145 for redundancy; use either port.
Connecting to the PBX PRI-U Port

The PRI-U port supporting 911 calls on the PBX requires a physical connection to the 9145. Four wires connect the PBX to the 9145 via the PRI-U port connector. Use a suitable straight-through cable such as Category 3 or better twisted pair for this connection.
ISDN PRI-U Connector Pinout (PBX)

The two transmit wires from the PBX must connect to the two receive wires of the 9145, and the two transmit wires from the 9145 must connect to the two receive wires of the PBX.

<table>
<thead>
<tr>
<th>9145 PRI-U Pin Number</th>
<th>Signal</th>
<th>Destination</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Transmit Tip</td>
<td>PBX Receive Tip</td>
</tr>
<tr>
<td>2</td>
<td>Transmit Ring</td>
<td>PBX Receive Ring</td>
</tr>
<tr>
<td>3</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>4</td>
<td>Receive Tip</td>
<td>PBX Transmit Tip</td>
</tr>
<tr>
<td>5</td>
<td>Receive Ring</td>
<td>PBX Transmit Ring</td>
</tr>
<tr>
<td>6</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>7</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>8</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
Connecting to the Telco Network PRI-N Port

The ISDN-PRI port from the Telco Network requires a physical connection to the 9145. This connection is usually made at a predetermined demarcation point such as a 66 or 110 punch down block. Four wires connect the Network to the 9145 via the PRI-N port connector. Use a suitable crossover cable such as Category 3 or better twisted pair for this connection.
ISDN PRI-N Connector Pinout (Network)

The two receiver wires from the Telco Network must connect to the two transmit wires of the 9145, and the two transmit wires from the 9145 must connect to the two receiver wires of the Telco Network.

<table>
<thead>
<tr>
<th>9145 PRI-U Pin Number</th>
<th>Signal</th>
<th>Destination (pin numbers may vary)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Receive Tip</td>
<td>Telco Network Transmit Tip</td>
</tr>
<tr>
<td>2</td>
<td>Receive Ring</td>
<td>Telco Network Transmit Ring</td>
</tr>
<tr>
<td>3</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>4</td>
<td>Transmit Tip</td>
<td>Telco Network Receive Tip</td>
</tr>
<tr>
<td>5</td>
<td>Transmit Ring</td>
<td>Telco Network Receive Ring</td>
</tr>
<tr>
<td>6</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>7</td>
<td>–</td>
<td>–</td>
</tr>
<tr>
<td>8</td>
<td>–</td>
<td>–</td>
</tr>
</tbody>
</table>
**Configuring the PBX**

The PBX must have the proper hardware and software configuration to function correctly with the 9145. The only hardware required is the ISDN-PRI port. The port must be configured to provide the following:

- Extended Super Frame (ESF) line framing
- B8ZS line coding
- Recovered loop or line clocking
- 100 ohm line impedance

In addition to the above ISDN-PRI port configuration, the PBX must also:

- Route all ‘911’ or ‘9+911’ calls to the ISDN-PRI port.
- Alternate route all ‘911’ or ‘9+911’ calls to other local CO trunks if the dedicated 911 ISDN-PRI port is busy or out of service.
- Provide the 911 calling party’s station number over the ISDN-PRI port.

The goal of the PBX configuration is to deliver all 911 calls to the 9145 so it can process them through to the 911 Network and report the event.

**Configuring the Administration PC**

A personal computer (PC) is required to configure and maintain the system. The PC is used to create, send and receive files to/from the 9145 and does not have to be dedicated to this application. Any PC with a LAN connection and Windows XP or higher operating system installed will work.

Log on to the PC using a local administrator account, and then install the Administration Program and the Event Log viewer from the supplied disc. These programs can be run from the Teo folder in the Start Menu.

Online help is available for both programs; press the F1 key or select Help from the program menu to view help topics.
Reporting Devices

Reporting of 911 call events along with the caller’s location is a system feature that allows customer personnel to be notified of the occurrence and location of a 911 call. Devices such as PCs with Alert Responder popup screens and text messaging cell phones can be used to inform personnel of the 911 emergency. System alarms and service interruptions can also be reported using these same devices.

Alert Responder PC Popup Screen

Client PCs configured with Alert Responder software can receive “Call in Progress”, “Call Completed”, “Alarm Set”, and “Alarm Clear” messages over the LAN; cellular telephones and alphanumeric pagers can receive these messages via email or text messages.

The Alert Responder software runs in the background, and will pop up in front of any other open windows when a message is received. Users can access the Alert Responder User Guide from the Teo folder in the Start Menu. To install the Alert Responder software, log on to each alerting PC using a local administrator account, and then install the software from the supplied disc. Configure the Remote Monitor software that is installed with the Alert Responder (page 34).
Cell Phone Reporting via Text Messages

The E911 Response Server 9145 can be configured to send call and/or alarm reports to text messaging cell phones via e-mail.

Configure the software on the Administration PC as follows:

1. Run the Administration program.
2. Click the Notify tab.
3. Enter the cell phone email address under Text Message Notify Address for the selected Notify Group.
   Consult your wireless service provider for this address, or visit www.teotech.com for a list of addresses.
4. Click OK.
Monitoring and Recording 911 Calls

Optional monitor ports allow dial-up call monitoring. Monitor ports are factory installed and must be purchased with the 9145. Configurations are available with two or four monitor ports.

Dial-up Call Monitoring

Using a 6-position modular line cord, connect each monitor port to an individual PBX station port. Only the center pair (pins 3 and 4) are used. Use the Administration program to configure the monitor ports. All ports will monitor the same call. A monitor port access telephone number and PIN must be assigned – see Administration online help.

Call Recording

The E911 Response Server 9145 saves call recordings as .wav files, which are identified with the date, time, and recording channel number.

Two recording ports are standard with every 9145. Up to two additional ports can be factory installed.

Call recordings can be accessed from the Alert Responder software’s completed call popup window, and from the Event Log viewer.
The 9145 is equipped with two redundant power supplies. Connect the power connectors on the back panel to standard 120 VAC, 60 Hz power outlets using the supplied IEC power cords. If multiple circuits are available at the equipment site, connect each power cord to a separate power circuit to ensure that the server will continue to operate if one circuit fails.

![Power Connectors](image)

Your system is configured in the computer BIOS to automatically start when power is connected. This setting ensures that the 9145 will restart in the event of a temporary loss of power.

To manually turn the 9145 off or on, press the power button (page 9).
Joining the Local Domain

The following additional equipment is required:

- Analog monitor with VGA connection
- Keyboard with PS/2 or USB connection
- Mouse or other pointing device with PS/2 or USB connection

1. Press the power button to turn off power to the 9145 (page 9).
2. Connect the monitor to the VGA Monitor port.
3. Connect the keyboard and mouse to the 9145. You can optionally use the front panel connectors if the keyboard and/or mouse have a USB connection.
4. Connect the 9145 to your LAN (page 19).

5. Turn on the power (page 9).

6. When the logon screen appears, logon to the local Administrator account.
   
   User name: Teo  
   Password: TEO911 (must be uppercase)

   **Be sure to change the default Administrator account password.** (Control Panel → User Accounts). **Record the new password for future reference.**

7. Open the System Properties control panel (Control Panel → System).

8. In the Computer name, domain, and workgroup settings section, click Change settings.

9. Click the Computer Name tab.

10. Enter a description of this server in the Computer description: field.

11. Click Change....
12. Enter a new computer name.
13. Click Domain: under Member of, and then enter the domain name.
14. Click More.

15. Enter the Primary DNS suffix.
16. Check the Change the primary DNS suffix when domain membership changes box.
17. Click OK.
18. Enter the name and password of a network account with permission to join the domain, and then click **OK**.

19. Click **OK** when the welcome message appears.

20. Click **OK** when prompted to restart.
Autologon

The 9145 must be logged on to enable the audio recording software. An autologon program is included; this will automatically log on to the network after powerup. Also, for security, set the screen saver to require a password to restore the desktop.

1. From the desktop, double-click **Autologon**.

![Autologon screenshot]

2. Enter the username and domain for the account that will be logged on during normal operation of the 9145.

3. Enter the password for the account. This password will be stored on the 9145 in an encrypted form.

4. Click **Enable**.

5. Open the **Personalization** control panel (**Control Panel → Personalization**).

![Personalization control panel screenshot]

6. Click **Screen Saver**.

7. Select a screen saver from the list.

8. In the **Wait** field, enter at least 10 minutes.

9. Check the **On resume, display logon screen** box.

10. Click **OK**.
Remote Monitor Configuration

Remote Monitor allows a user of the Alert Responder software to monitor calls in progress. It must be initially configured with the 9145 server name, and a logon name and password. Perform this procedure at each client PC where the Alert Responder software is installed (typically not the Administration PC).

1. From the Start Menu, select All Programs → Teo → Teo Remote Monitor. A splash screen will be shown briefly, and then the following dialog will appear.

2. In the Server field, enter the computer name of the 9145 (the name was set when joining the domain, see page 30).

3. In the User Name and Password fields, enter monitor.

4. Click the Close (Close) button. You do not need to connect.
System Administration

An Administration PC is required to create, send, and receive data to/from the E911 Response Server 9145. The PC does not have to be dedicated to the 9145. The Administration PC can be any PC running Windows XP or higher.

The Administration PC is used for the following major system functions:

- Configuring the 9145
- Station Data updates
- Viewing the Event Log File

Two programs are loaded onto the Administration PC: Teo E911 Response Server Administration program, and Teo E911 Response Server Event Log viewer (page 53).

The Administration PC communicates with the 9145 over the LAN.
Software Installation

Installers for the Administration program, Event Log viewer, and Alert Responder are on a disc supplied with the E911 Response Server 9145; updates may be available from www.teotech.com.

- Install the Administration program and Event Log viewer on each PC that will be used to administer the E911 Response Server 9145. Independent usernames and passwords are used to log on to the Administration program and Event Log viewer.
- Install the Alert Responder software on all PCs that will receive alert notification popups.

Both the Administration program and Event Log viewer include extensive online help. Basic operation and programming information is in this manual; always refer to online help for the latest detailed information.

Help is accessed by pressing F1 or selecting Contents and Index from the Help menu.

Using the System Administration Program

The configuration and station data programmed with the Administration program directly affects the appearance of the Alert Responder popup screens.

In the example popup screen below, The Calling Station, Inside Location, Dispatch Location, Directions, Callback Number, Alert, Dialup Monitor, PC Remote Monitor fields as well as the PDF image are all determined by the data entered with the Administration program.

Multiple tabs are available for viewing detailed information regarding the 911 call.

Tabs 3, 4, 5, and 6 are named and defined with the administration program.

The graphics for each tab are PDF files and are determined with the administration program. The PDF files will automatically resize to fit the popup screen.

Refer to the Teo E911 Response Server – Alert Responder User Guide for detailed descriptions of the popup screens.
Along with determining the appearance of Alert Responder popup screens, other key features are set by the Administration program.

1. 911 call notifications can be sent to recipients via email. The Administration program is used to enter email addresses of recipients.

2. Text messages can be delivered to cellular telephones via email. The Administration program is used to enter email addresses of recipients.

3. The Administration program is used to determine how alarms are handled, who receives them, and how they are sent (via email, popup, text messaging etc.).

4. The Administration program is used to determine the 10-digit number sent when a PBX station dials 911.
Initiating an Administration Session

From the Start Menu, select All Programs → Teo → Teo E911 Response Server Administration. The Connect to Server dialog will open.

![Connect to Server dialog](image)

Enter in the network name or IP Address that was assigned to the 9145 server. The default port is “5992”. The default Username is admin, and the default password is admin. Click OK to log on.

Be sure to change the “admin” account password from the default, and record the new password for future reference. You can also create additional user accounts – select Manage Users from the File menu.

A window similar to this will open. Each tab is populated with data retrieved from the E911 Response Server 9145. Every time you connect to the 9145, the administration program retrieves the configuration and station data.
Email Set up

Select **File** → **Email Setup**.

The Email Setup dialog will open.

The E911 Response Server 9145 can send alerts via email, and can also send email alerts to text messaging cellular telephones.

This window identifies the **from** email address, and the SMTP Host name used to send email.

Enter in the appropriate data for your company.

Click **OK** when done.
PRI Setup Tab

**Line Build Out** by default is **0.0 dB**. Signal levels may be attenuated if you suspect that the PBX or C.O. equipment is being overdriven; otherwise, leave this field at 0.0 dB.

**Line Coding** should normally be left at **B8ZS** (bipolar with eight zero substitution). **AMI** (Alternate Mark Inversion) should only be used with older signaling systems. AMI is typically associated with T1, and not with ISDN.

The **D** (data) **Channel** is normally time slot **24**. Channels 1 through 23 are normally B or voice channels. The D channel time slot must match the PBX and C.O. assigned D channel time slot.

**Warning:** The 9145 is intended for ISDN-PRI lines with a maximum of 23 B channels only. Do not connect the 9145 to ISDN-PRI lines where a primary and a secondary D channel are used, and more than 23 B channels are supported.
Port Setup Tab

The 9145 comes equipped with a minimum of two record ports. Port’s 1 and 2 will always be record ports.

Ports 3 and 4 can be record, monitor, or not equipped.

Ports 5 and 6 will be monitor, or not equipped.

The **Ports Installed** field and individual **Port** and **Type** fields will be preconfigured at the factory by TEO.

If monitoring is an option, analog stations or outside lines will be attached to the monitor ports. A **Dial-up Monitor Number** must be assigned to the ports. Enter the appropriate number.

The PIN is a number assigned as a password. After you dial the monitor port number, the 9145 provides a clicking sound to let you know you can enter the password. In this example, you dial 123 then # and can listen to the 911 call in progress.

The **Monitor Beep Tone** and **Recording Beep Tone** are provided for legal reasons. The beep tone may be required by law if a call is being monitored or recorded. Check your local and state law to determine if calls can be observed or recorded.
Call Masking Tab

Call masking is used to replace your caller ID on “non-911” outbound calls. Sensitive areas such as a school class room may want to block or “mask” their telephone number from appearing for caller ID. A front desk administration telephone number or a pilot number may be substituted for your caller ID when an outside call is placed.

If you want call masking, then check Replace Non-E911 Calling party Number.

Enter up to 255 telephone numbers in the table.

Each Non-E911 Call Mask Group is assigned a ten digit number.

When the station number data is entered later on, each station will be assigned a group number.

If station 1037 is assigned group 2, then when station 1037 places a non-911 call, the number that will be sent for caller ID is 8885551234 as shown in the table above.
Notification Tab

The notification tab defines who will receive pop-ups, who will be notified by email, and who will receive text messages on their cellular phones.

**NotifyGroup**
Station numbers and devices are assigned group numbers. For example, station numbers and devices in building 1 may be assigned to NotifyGroup 1, and station numbers and devices in building 2 may be assigned to NotifyGroup 2. If a 911 call originates in building 1, only NotifyGroup 1 devices will receive notification.

**Notifyee**
The notifyee is the name of the person receiving notification.

**Popup PC Name**
This is the PC network name or IP Address of a PC with Alert Responder software installed.

**Email Notify Address**
Enter a valid email address or leave blank.

**Text Message Notify Address**
Enter email address of a cellular phone (10-digit@carrier.com) or leave blank.
**Include Record Message**
If this field is checked, the PC popup user will be notified that the call is being recorded and on what channel.
At the end of the call, the PC popup user and Email Notify Address will be sent an indication of the file name where the recorded message exist.

**Include Monitor Message**
Check this field to include PC Remote Monitor notification for Alert Responder popup alerts, and optional Dial-up Monitor notification for Alert Responder popups and email notifications.

**Dispatch Info Tab**

Click **Add Customer**. The Edit Customer screen will appear.
Items marked in red are mandatory. All other items are optional and may only be required if you are trying to setup a file that can be exported to a NENA format. NENA (National Emergency Number Association) is a 911 standards organization.

Data files exported to a NENA format may be used to update the 911 Call Takers database. 911 operators access a database that matches your telephone number (Automatic Number Identification ANI) to a corresponding address (Automatic Location Identification ALI).

A description of some of the fields follows. Number ranges in parentheses represent the record position for NENA records. For a description of some of the fields not mentioned here, refer to the Administration program online help.

**General Info**

- **Main Number** – 10-digit telephone number of the Main Number associated with the Calling Number. *(234-240)*
- **Customer Name** – subscriber name associated with the Calling Number. *(188-219)*
- **Order Number** – service order number for the activity establishing this customer record. *(241-250)*
**Street Address**

- **House Number*** – address number of the Calling Number building, 10 characters max. (some telephone companies may only support 8 characters). (12-21)
- **House Number Suffix** – house number extension (e.g. ½). (22-25)
- **Prefix Directional** – leading street direction prefix: N, S, E, W, NE, NW, SE, or SW. (26-27)
- **Street Name*** – service address of the Calling Number. (28-87)
- **Street Suffix** – street abbreviation, as defined by the U. S. Postal Service Publication 28, Appendix C. (e.g. AVE). (88-91)
- **Post Directional** – trailing street direction suffix: N, S, E, W, NE, NW, SE, or SW. (92-93)
- **Community (City)*** – service community of the street name/house number as designated by the MSAG. (94-125)
- **State*** – alpha state abbreviation (e.g. TX). (126-127)
- **Zip + 4** – postal Zip Code Extension. (272-275)

**Popup Tab PDF Files**

PDF files stored in the E911 Response Server 9145 can be selected from a dropdown list. To send a new PDF file to the 9145, Click **Upload...**, then select a file from your PC or network.

- **Location Tab** – PDF file to be displayed in Tab 1 of the call alert popup.
- **Event Info Tab** – PDF file to be displayed in Tab 2 of the call alert popup.
- **Tab 5** – PDF file to be displayed in Tab 5 of the call alert popup.
- **Tab 6** – PDF file to be displayed in Tab 6 of the call alert popup.
An example of a programmed Edit Customer screen is shown below.
Multiple E911 Calling Numbers can share common customer site information (e.g. street address) to streamline data entry for ALI Data Exchange. Individual “E911 Dispatch Locations” within a site can be assigned to unique “E911 Calling Numbers” from the site. “E911 Dispatch Location” descriptions can be used to direct emergency responders to an interior location or zone (such as room or floor number) within a building or campus site.

To edit customer dispatch locations:

1. Click the **Dispatch Info** tab.
2. If the customer is not listed in the table, add the customer before proceeding.
3. Click the customer in the table. A list of E911 Calling Numbers and E911 Dispatch Locations will appear below the customer’s Name, Main Number, and Address.
4. Click in an **E911 Calling Number (ANI)** field to edit, or click a blank field at the end of the list to create a new entry. E911 Calling Numbers must be 7 digits for the 9135, and 10 digits for the 9145.
5. Click in an **E911 Dispatch Location** field to enter or edit a location description (50 characters max.).

To delete customer dispatch locations:

1. Click anywhere in the dispatch table line that you want to delete (do not double-click to edit a field).
2. Hold down **Ctrl** while clicking if you want to select multiple locations; hold down **Shift** to select a contiguous block.
3. Press **Delete**.
NENA Header/Trailer Tab

The header and trailer records enclose the NENA Version 2.1 Format ALI data exchange information.

To edit NENA Header/Trailer data:

1. Click the NENA Header/Trailer tab.
2. You can edit the following fields. Consult with your service provider for details.

   Items in parentheses are location of the field (header, trailer, or both), and the record position in NENA Version 2.1 data exchange format; refer to the NENA-02-010 document.

   - Company Name (Header, Trailer 12-61)
   - Cycle Counter (Header 62-67)
   - Release Number (Header 94-96)
   - Format Version (Header 97)
   - Header General Use (Header 74-93)
   - Header Reserved (Header 106-511)
   - Trailer Reserved (Trailer 79-511)

NENA data is only necessary if you are planning on exporting data to an ALI database.
Station Info Tab

- **Number DIALED for Emergency** – typically 911 but is programmable so that a number such as 711 can be used for testing so that calls are not being sent to 911 operators during turn-up. Enter 911 here.

- **E911 Calling Number (ANI)** – should be the pilot number for your organization. If for some reason the 9145 does not recognize the calling station number, this number will be sent to 911 operators.

- **E911 Notify group** – used to select a notify group that will receive an alert notification when an emergency call from an unknown station occurs.

- **Station Number Length** – a PBX will typically use 3, 4, or 5 digit dialing to place a station to station call. Enter the number of digits required for your organization.

- **Callback Number** – this number will be displayed at the PSAP operator’s position as a callback number when a call comes from an unknown station.

- **Send Admin Alert** – instructs the unit to send alert notification to the admin notify group when a call occurs from an unknown station.
If you select **Add Station**, the Edit Station window appears.

![Edit Station Window](image)

1. Edit all required entries.
   - **Station Name** – the name of the station user.
   - **Station Number** – the PBX number assigned to the station, normally used to call the station.
   - **Callback Number** – a number that emergency responders can use to call the emergency caller, typically the full dialable (DID) station number.
   - **E911 Calling Number (ANI)** – the calling number sent to the 911 operator at the PSAP.
   - **Inside Location** – the physical location of the station within the building or campus.
   - **Directions** – instructions to assist emergency personnel in finding the station location.
   - **E911 Notify Group** – the group of notifyees who will be alerted when an emergency call originates from this station. Select a Notify Group from the dropdown list. Notify Groups are defined in the Notification tab.
   - **Non-E911 Call Mask Group** – the alternate Call Mask Group (caller ID number). Select a Call Mask Group from the dropdown list. Group 0 disables call masking for the station. This item takes effect only when system-wide call masking is enabled.
• **Popup Tab 3/4 PDF File** – tabs 3 and 4 in the popup notification can display customized PDF files for each station. PDF files are stored in the E911 Response Server 9145. Select a file from the dropdown list. To add a new PDF file to the E911 Response Server 9145 and to the list, click **Upload...**, and then select a file from your local disk or network.

• **Alert** – additional information for emergency personnel about the user or location, such as hazards or medical conditions.

2. When finished, click **OK**.

### Updating the 9145 Database

After all data has been entered, the data still must be sent to the 9145. Up to this point, the data only exist on the Administration PC

Select File→Publish to Server→Configuration.

After the configuration has been sent, select File→Publish to Server→Station Data. The station data will be sent

The next time you connect to the 9145, the configuration and station data you just sent will be retrieved automatically. After the initial configuration and station data has been sent, the data received can be updated to account for moves, adds, and changes and then sent (published) to the unit.

### Backing up Configuration and Station Data

The configuration and station data can be backed up locally on the Administration PC.

With the administration program open and a connection to the 9145 established, select File→Save As, and then enter a name and location to save your configuration data. The configuration data should have an extension of “.config”.

To save the station data, select File→Export→Station Data (csv) and give the file a name and location. Station data is saved as a comma delimited (.csv) file.
Using the Event Log Viewer

The 9145 stores all call and alarm history in a log file. The alarm detail indicates the time of alarm, type of alarm, duration etc. The call activity indicated calling number, time of event, location of the caller and other detailed information.

Retrieving Log Files

From the Start Menu, select All Programs→Teo→Teo E911 Response Server Event Log. The Connect to Server dialog will open.

Enter in the network name or IP Address that was assigned to the 9145 server. The default port is “5992”. The default Username is events, and the default password is events. Click OK.

The event list will be shown. Each event can be selected and a detailed screen will open.
The alarm screen will show the type of alarm, when it occurred, and if the alarm has been cleared, the alarm duration will be shown.

For detailed information on viewing alarms, refer to the help file.
The call screen allows you to look at call detail as well as listen to the call. In the example shown, if you select the speaker button, you can listen to the call on your Windows media player.
Detailed explanation of each field can be found in the help file.
This section describes the system status and control functions along with call and alarm record formats. For normal operation, the front panel indicators should be either OFF or GREEN and Configuration Switches 1-4 should be in the OFF (down) or deactivated state.

A system level override of the front panel indicators occurs when the 9145 is unable to load the functional software on power up. In this case, all front panel indicators will be either solid YELLOW or FLASHING YELLOW to indicate that the 9145 is running from EPROM memory. Contact Teo Technical Support if this condition occurs.

The 9145 front panel indicators show:
- Overall System Status
- PBX ISDN-PRI Status
- Telco Network ISDN-PRI Status
- Alarm Status
- 911 Call Status

More detailed status information is also available through a connection with the Administration PC. Refer to the System Administration section.

Switches on the front panel allow for basic configuration of the 9145. These switches control:
- System Self Test Mode / Bypass
- Diagnostics (for Teo use only)
Line Status Indicators

Indicators are described on page 9.

Any of the 23 B Channels (voice channels) of the ISDN-PRI connection can process a 911 call.

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>No 911 call activity (idle).</td>
</tr>
<tr>
<td>Solid Yellow</td>
<td>911 Call Setup is in progress, no voice connection established.</td>
</tr>
<tr>
<td>Solid Green</td>
<td>911 call in progress, voice connection established.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>System Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flashing Green</td>
<td>Normal, OK</td>
<td>Power applied and processor functioning correctly.</td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>System Test Mode</td>
<td>Self Test Mode Switch is activated or missing administration files.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Not Functioning</td>
<td>Self Test failure.</td>
</tr>
<tr>
<td>OFF</td>
<td>Not Functioning</td>
<td>Power not applied or system not functioning.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>PRI-U Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Normal, OK</td>
<td>The PRI-U port is functioning properly.</td>
</tr>
<tr>
<td>Solid Yellow</td>
<td>PBX Out of Service</td>
<td>The 9145 is receiving Remote Alarm Indication (RAI), also known as a Yellow Alarm.</td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>9145 Out of Service</td>
<td>The 9145 is transmitting Remote Alarm Indication (RAI), also known as a Yellow Alarm. Check system Active Alarms for details.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Malfunctioning</td>
<td>PRI-U Bipolar Violations or Frame Slips have occurred.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Not Functioning</td>
<td>The 9145 is receiving an Alarm Indication Signal (AIS), also known as a Blue Alarm.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Not Functioning</td>
<td>No ISDN-PRI digital signal is being detected, Loss of Signal (LOS).</td>
</tr>
<tr>
<td>OFF</td>
<td>Not Functioning</td>
<td>Power not applied, system not functioning.</td>
</tr>
</tbody>
</table>
### PRI-N Status

<table>
<thead>
<tr>
<th>PRI-N Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Normal, OK</td>
<td>The PRI-N port is functioning properly.</td>
</tr>
<tr>
<td>Solid Yellow</td>
<td>Telco Network</td>
<td>The 9145 is receiving Remote Alarm Indication (RAI), also known as a Yellow Alarm.</td>
</tr>
<tr>
<td></td>
<td>Out of Service</td>
<td></td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>9145 Out of Service</td>
<td>The 9145 is transmitting Remote Alarm Indication (RAI), also known as a Yellow Alarm. Check system Active Alarms for details.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Malfunctioning</td>
<td>PRI-N Bipolar Violations or Frame Slips have occurred.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Not Functioning</td>
<td>The 9145 is receiving an Alarm Indication Signal (AIS), also known as a Blue Alarm.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Not Functioning</td>
<td>No ISDN-PRI digital signal is being detected, Loss of Signal (LOS).</td>
</tr>
<tr>
<td>OFF</td>
<td>Not Functioning</td>
<td>Power not applied, system not functioning.</td>
</tr>
</tbody>
</table>

### Alarm Status

<table>
<thead>
<tr>
<th>Alarm Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>Normal, OK</td>
<td>No alarm condition exists.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Alarm Active</td>
<td>Alarm exists.</td>
</tr>
</tbody>
</table>
Switches

Configuration Switch 1 initiates a self-test mode, and bypasses the 9145. When enabled, the 9145 will perform internal self tests and ISDN-PRI loopback tests. Refer to the Testing and Troubleshooting sections.

Internal relays provide a direct connection between the PBX and CO ISDN-PRI lines in the event of a power outage or during a self test. You can use this option during installation troubleshooting to remove the 9145 from the circuit.

**NOTE** – The activation (up) of the Self Test / Bypass Switch causes the 9145 to stop processing all calls from the PBX. It is recommended that this switch be enabled for 10 seconds and then disabled.

The System Status indicator displays the PASS/FAIL results of the self test after the self test switch is disabled. A flashing green indication means the test passed and a flashing red means it failed.

System Self Test can also be enabled and the results viewed by using the Administration PC. Refer to the System Administration section.

<table>
<thead>
<tr>
<th>Switch Identification</th>
<th>Switch Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Self Test/ Bypass</td>
</tr>
<tr>
<td></td>
<td>ON (up) = Self test, 9145 is bypassed</td>
</tr>
<tr>
<td></td>
<td>OFF (down) = Normal operation</td>
</tr>
<tr>
<td>2 - 4</td>
<td>Reserved for Factory Use</td>
</tr>
<tr>
<td></td>
<td>Must be set to OFF (down).</td>
</tr>
</tbody>
</table>
Reporting

Reporting of 911 call events along with the caller’s location is a system feature that allows customer personnel to be notified of the occurrence and location of the 911 call. Reporting devices such as cellular telephones, alphanumeric pagers, printers, and PC “pop-up” screens can be used to inform personnel of the 911 emergency. System alarms and service interruptions can also be reported using these same devices.

This section describes the types of messages generated, their content, and the format in which they are presented for various reporting devices. The following describes the messages sent to each type of reporting device:

<table>
<thead>
<tr>
<th>Reporting Device</th>
<th>Call Start Record</th>
<th>Call End Record</th>
<th>Alarm Records</th>
<th>Programmable for Calls and/or Alarms</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Log File</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Email</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Cell Phones and Pagers</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Alert Responder Popup Screens</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>
Call Monitoring and Recording

Dial-up Call Monitoring

Call monitor ports on the 9145 are connected to PBX station ports or to analog outside lines. To monitor 911 calls, call the PBX monitor station port from another extension or, if allowed, a telephone line external to the PBX.

Repeated clicks indicate that the 9145 has “answered” your call and is waiting for the optional password. Enter the password with the calling phone’s dial pad, followed by the # key. The password is set by the 9145 Administration Program.

You will hear the oldest 911 call. When that call has finished, you will be connected to the next-oldest call, if any, otherwise, the monitor port will disconnect. An optional beep tone can be periodically sent to the 911 caller, Call Taker, and the monitor port as a notification that the call is being monitored.

Multiple monitor ports may be configured on the 9145, allowing several users to simultaneously monitor 911 calls. All ports monitor the same call.

Call Recording

An internal voice recorder will automatically start recording when a 911 call is active. Recording is started and stopped automatically. The E911 Response Server 9145 comes equipped with two-channel recording capability. Two additional recorder ports may be ordered by the customer and factory installed.

An optional beep tone can be periodically sent to the 911 caller, Call Taker, and the recorder as a notification that the call is being recorded.

The oldest 911 call is sent to the first available channel. Newer calls are each sent to the next available channel, or, if all channels are busy, to the first channel to become idle.
Alarms

Overview

The 9145 continuously monitors all internal major system components, along with the internal/external data streams (ISDN-PRI), for alarm conditions. If an alarm condition is detected or a system malfunction occurs, the 9145 is designed to:

- Illuminate the front panel Alarm indicator.
- Send Alarm Records to a Log file for diagnosing system problems.
- Send Alarm Records to Alert Responder popup software.
- Send Alarm Records to text messaging cellular telephones
- Send Alarm Records to alphanumeric pagers.
- Send Alarm Records to an email address.

This section describes the alarm records generated by the 9145 and provides examples of actual alarm record text and how to correct the condition.

The alarm records are separated into five main categories:

- File Alarms
- Hardware Alarms
- Reporting Alarms
- ISDN-PRI Alarms
- PRI Status Alarm

Alarm Records

Alarm Records are reported to printers, alphanumeric pagers and Alert Responder PCs, providing these devices are programmed in Administration program.

Alarm Records are automatically generated when the system detects specific alarm conditions. They contain the date and time of the alarm, a field for ALARM SET or CLEAR, and a brief description of the alarm. The following example shows the content and format of some actual Alarm Records:
## File Alarms

<table>
<thead>
<tr>
<th>Alarm Text</th>
<th>Alarm Description</th>
<th>Alarm Clearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illegal Executable</td>
<td>9145 detects an invalid or missing executable operating system.</td>
<td>Using the Administration PC, connect and select <strong>Publish to Server</strong> → <strong>Firmware Update</strong> to clear the alarm.</td>
</tr>
<tr>
<td>Illegal Configuration File</td>
<td>9145 detects an invalid configuration.</td>
<td>Using the Administration PC, connect and select <strong>Publish to Server</strong> → <strong>Configuration</strong> to clear the alarm.</td>
</tr>
<tr>
<td>Configuration File Missing</td>
<td>9145 detects a missing configuration.</td>
<td>Using the Administration PC, connect and select <strong>Publish to Server</strong> → <strong>Configuration</strong> to clear the alarm.</td>
</tr>
<tr>
<td>Illegal Station Table</td>
<td>9145 detects an invalid Station Table.</td>
<td>Using the Administration PC, connect and select <strong>Publish to Server</strong> → <strong>Station Data</strong> to clear the alarm.</td>
</tr>
<tr>
<td>Station Table Missing</td>
<td>9145 detects a missing Station Table.</td>
<td>Using the Administration PC, connect and select <strong>Publish to Server</strong> → <strong>Station Data</strong> to clear the alarm.</td>
</tr>
<tr>
<td>All Flash Sectors Full</td>
<td>Flash memory is full or the 9145 detects a memory error.</td>
<td>Perform a system reset and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
</tbody>
</table>
## Hardware Alarms

<table>
<thead>
<tr>
<th>Alarm Text</th>
<th>Alarm Description</th>
<th>Alarm Clearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Illegal Flash Memory</td>
<td>9145 generates this alarm if the flash memory is corrupted.</td>
<td>Perform Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>Flash Write/Erase Failure</td>
<td>9145 is detecting flash memory errors.</td>
<td>Perform a Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>RAM Test Failed</td>
<td>9145 is detecting RAM memory errors.</td>
<td>Perform a Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>FRAMER #1 Test Failed</td>
<td>9145 cannot communicate with the first ISDN Framer IC in the system.</td>
<td>Perform a Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>FRAMER #2 Test Failed</td>
<td>9145 cannot communicate with the second ISDN Framer IC in the system.</td>
<td>Perform a Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support.</td>
</tr>
</tbody>
</table>
| Monitor Port Not Responding| 9145 cannot communicate with the internal monitor port circuitry.                  | Use the Administration program to verify that the number of monitor ports installed equals the number of monitor ports present in the 9145.  

  or

  Perform a Reset Controller and/or power cycle. If the alarm persists, contact Teo Technical Support. |
## ISDN PRI-U Alarms

<table>
<thead>
<tr>
<th>Alarm Text</th>
<th>Alarm Description</th>
<th>Alarm Clearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISDN PRI-U</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transmit AIS</td>
<td>The 9145 does not detect an incoming ISDN signal from the PBX and is responding by transmitting the AIS (Alarm Indicating Signal also known as Blue Alarm).</td>
<td>Verify the ISDN PRI-U connection from the PBX transmit pair to the 9145 receive pair.</td>
</tr>
<tr>
<td>Transmit RAI</td>
<td>The 9145 is in an out of service condition and not ready to process 911 calls from the PBX. The unit is transmitting the RAI (Remote Alarm Indication, also known as Yellow Alarm) signal to indicate this condition.</td>
<td>This alarm is normal during power up conditions, but should never persist for more than 60 seconds. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>Receive AIS</td>
<td>The 9145 is receiving the AIS (Alarm Indicating Signal also known as Blue Alarm) signal from the PBX. This indicates that the PBX does not detect an incoming ISDN signal from the 9145.</td>
<td>Verify the ISDN PRI-U connection from the 9145 transmit pair to the PBX receive pair.</td>
</tr>
<tr>
<td>Receive RAI</td>
<td>The PBX is in an out of service condition and not ready to process 911 calls to the 9145. The PBX is transmitting the RAI (Remote Alarm Indication, also known as Yellow Alarm) signal to indicate this condition.</td>
<td>This alarm is normal during power up conditions, but should never persist for more than 60 seconds. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>Receive BPVs</td>
<td>Bipolar Violations (BPVs) or Excessive Zeros ISDN Line Coding condition.</td>
<td>Make sure that the PBX line coding is configured for Bipolar 8 Zeros Substitution (B8ZS). Electrical noise on the ISDN-PRI line can also cause this.</td>
</tr>
<tr>
<td>Receive Slip</td>
<td>ISDN-PRI Frame Slip condition.</td>
<td>Make sure that the PBX is configured for a recovered clock source (line or loop clock).</td>
</tr>
</tbody>
</table>
# ISDN PRI-N Alarms

<table>
<thead>
<tr>
<th>Alarm Text</th>
<th>Alarm Description</th>
<th>Alarm Clearing</th>
</tr>
</thead>
<tbody>
<tr>
<td>ISDN PRI-N</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Transmit AIS</td>
<td>The 9145 does not detect an incoming ISDN signal from the Network and is responding by transmitting the AIS (Alarm Indicating Signal also known as Blue Alarm).</td>
<td>Verify the PRI-N connection from the Network transmit pair to the 9145 receive pair.</td>
</tr>
<tr>
<td>Transmit RAI</td>
<td>The 9145 is in an out of service condition and not ready to process 911 calls to the Network. The unit is transmitting the RAI (Remote Alarm Indication, also known as Yellow Alarm) signal to indicate this condition.</td>
<td>This alarm is normal during power up conditions, but should never persist for more than 60 seconds. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>Receive AIS</td>
<td>The 9145 is receiving the AIS (Alarm Indicating Signal also known as Blue Alarm) signal from the Network. This indicates that the Network does not detect an incoming ISDN signal from the 9145.</td>
<td>Verify the PRI-N connection from the 9145 transmit pair to the PBX receive pair.</td>
</tr>
<tr>
<td>Receive RAI</td>
<td>The Network is in an out of service condition and not ready to process 911 calls to the Network. The Network is transmitting the RAI (Remote Alarm Indication, also known as Yellow Alarm) signal to indicate this condition.</td>
<td>This alarm is normal during power up conditions, but should never persist for more than 60 seconds. If the alarm persists, contact Teo Technical Support.</td>
</tr>
<tr>
<td>Receive BPVs</td>
<td>Bipolar Violations (BPVs) or Excessive Zeros ISDN Line Coding condition.</td>
<td>Make sure that the Network line coding is configured for Bipolar 8 Zeros Substitution (B8ZS). Electrical noise on the ISDN-PRI line can also cause this.</td>
</tr>
<tr>
<td>Receive Slip</td>
<td>PRI-N Frame Slip condition.</td>
<td>Make sure that the PBX is configured for a recovered clock source (line or loop clock).</td>
</tr>
</tbody>
</table>
### Status Messages

<table>
<thead>
<tr>
<th>Status Text</th>
<th>Status Description</th>
<th>Clearing Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Force Interrupt Recovery</td>
<td>The ISDN framer interrupt was restarted.</td>
<td>This may be caused by excessive line noise. Ensure that the cabling is CAT3 minimum. Flat silver satin cable can cause this problem.</td>
</tr>
<tr>
<td>Self Test Mode</td>
<td>Status message indicating that the front panel Self Test switch or the Configuration file Self Test switch has been activated.</td>
<td>Deactivate the Self Test switch.</td>
</tr>
</tbody>
</table>

### Alarm Status

<table>
<thead>
<tr>
<th>Alarm Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>OFF</td>
<td>Normal, OK</td>
<td>No alarm condition exists.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Alarm Active</td>
<td>Alarm exists.</td>
</tr>
</tbody>
</table>
Verifying Proper Operation

Indicator Verification

The 9145 has front panel indicators that allow quick verification of proper operation. The indicators must all be indicating proper operation before any testing is attempted.

Verify the following:

<table>
<thead>
<tr>
<th>Indicator</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>PRI-U (PBX)</td>
<td>Solid Green</td>
</tr>
<tr>
<td>PRI-N (Network)</td>
<td>Solid Green</td>
</tr>
<tr>
<td>Alarm</td>
<td>OFF</td>
</tr>
<tr>
<td>911 Calls in Progress</td>
<td>OFF (no calls)</td>
</tr>
</tbody>
</table>

If any one of the indicators is not as described above, refer to the System Operation and Troubleshooting sections before proceeding.

Administration PC Verification

The Administration PC can be used to remotely verify system operation. Receive the event log and verify that no active alarms are present. Any alarms displayed should have a duration time stamp indicating that the alarm condition has cleared. If an alarm is displayed and there is no duration time stamp, it may be possible that it is an old alarm and the unit has had power cycled a couple of times during turn-up. You can have someone visually inspect the front panel alarm indicator if in doubt.

Self Test Procedures

Several of the product’s subsystems including the ISDN-PRI ports can be verified using the Self Test switch. Self test can be performed with the front panel Self Test switch.

To initiate a Self Test:
1. Activate the Self Test switch
2. Wait 10 Seconds
3. Deactivate the Self Test switch

The system status indicator is used to verify a self test pass/failure.
A flashing green Status indicator means the self test passed, and a flashing red status indicator means the test failed. If the test failed, contact Teo tech support.
Generating Test Calls

Live 911 Test Calls

Live 911 test calls must be made to ensure that the PBX, 9145, and C.O. ISDN-PRI circuits are functioning correctly.

1. Place a 911 Call from a PBX station.
2. Verify that the front panel call status indicator is green, indicating that the call was sent to the system.
3. Listen for ringback tone.
4. When the 911 Call Taker answers, indicate that this is a test call and ask for the 10-digit telephone number (ANI) displayed. **Do not hang up on the Call Taker without speaking.**
5. Hang up the 911 calling station.
6. Using the Event Log viewer, retrieve the Event Log and examine event record for the test call.
7. Verify that the time/date, PBX station number, translated ANI number, and address are correct.
8. Verify that the 10-digit number in the call event record matches the number reported by the 911 Call Taker.

Perform this test with at least 10 stations.

Many PBXs are in a networked environment where you may have a host PBX and remote PBXs attached. An example might be a school district where there are multiple sites that all route their 911 calls through the 9145 located with the host. In this case, it’s important to place test calls from each remote location.

Verify Call Reporting

Each of the reporting devices defined with the Administration program must be tested for proper operation. Alert Responder PCs, text messaging cellular telephones, and email clients should each be tested to ensure that they are capable of receiving 911 call notification. Some Alert Responder PCs may only be set up to receive alarm notification.

Stations and reporting devices may be assigned group numbers. 911 call notification from a station assigned to group 2 will only be reported to a reporting device assigned to group 2. You may have to generate test calls from each group to test reporting devices or assign a station to group 0 for testing purposes. A station assigned to group 0 will cause notification to be sent to every device regardless of the devices’ group number assignment.
Generating Alarms

Any device setup to receive alarms must be tested. Alert Responder PCs and text messaging cellular telephones are usually set up to receive alarms.

Verify Alarm Reporting

Verification of a reporting device includes checking the time/date, Alarm SET/CLEAR status and Alarm text for each alarm generated. The following steps can be used to create an alarm.

1. Verify that no system alarms exist before proceeding.
2. To create an alarm, unplug the ISDN PRI-U connector from the 9145.
3. An alarm (PRI-U Transmit AIS – Lost Signal) will be generated in approximately 60 seconds.
4. Verify that devices set up to receive alarms receive an alarm set message.
5. Verify the 9145 alarm indicator is on RED.
6. Plug in the ISDN PRI-U connector.
7. Verify that the alarm clears. The alarm lamp should go out, and the reporting devices should receive an alarm clear message.
8. Retrieve the event log and verify that you see the alarm with the correct date/time, the alarm indicates PRI-U lost signal, and the alarm has a duration time stamp indicating that it was created and cleared.
PBX Configuration Testing

The PBX must be tested to ensure that 911 call overflow and Out of Service conditions are handled correctly.

Overflow conditions are handled by the PBX. 911 calls should always have alternate routing assigned in case the primary call path becomes unavailable.

If the 9145 ISDN line becomes busy because of too many calls, or the ISDN line is out of service, the most important thing is for the call to complete to an operator even if that means the operator only gets a pilot number.

Overflow Testing

In the case where the PBX has more than one ISDN-PRI line, one or more of the additional ISDN lines should be set as an overflow path.

Unplug the ISDN-PRI U line from the 9145. Place a test call. The 911 call should route out one of the overflow lines. Verify that the call routes to a 911 Call Taker. The number (ANI) that the Call Taker receives may be the station number, but it may also be a pilot number depending on the PBX and CO settings.

9145 Out of Service

Remove power from the 9145 Server. The 9145 is designed to cut the ISDN-U (PBX) side through to the ISDN-N (CO) side. Place a test call and verify the call connects through to the 911 operator. The operator may receive the station number or a pilot number. Re-apply power to the 9145. Verify that normal operation resumes.

Testing Networked PBXs

In a networked environment such as school district, there may be multiple remote locations that route 911 calls through a single ISDN-PRI line. A test call must be made from each location to ensure the remote switches are delivering the PBX station number to the host, and that the host in turn is capable of delivering the station number to the 9145.

You can retrieve the event log to verify the calling station number and 10 digit number sent for each of the test calls.
Status Indicators

The 9145 has front panel indicators that allow verification of proper operation. The indicators must all be indicating proper operation as shown below.

The following sections aid in troubleshooting indicated status problems.

System Status Indicator is Not Flashing Green

<table>
<thead>
<tr>
<th>System Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Flashing Green</td>
<td>Normal, OK</td>
<td>Power is applied and processor is functioning correctly.</td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>System Test Mode or Missing Configuration</td>
<td>Self Test Mode is activated or missing Administration configuration.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Not Functioning</td>
<td>Self Test Failure.</td>
</tr>
<tr>
<td>OFF</td>
<td>Not Functioning</td>
<td>Power is not applied or system is not functioning.</td>
</tr>
</tbody>
</table>

If the indicator is Flashing Yellow, deactivate the Self Test switch or check the active alarms to determine if configuration settings are missing.

If the indicator indicates a “Not Functioning” state, contact Teo Technical Support.
<table>
<thead>
<tr>
<th>PRI-U / PRI-N Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid Green</td>
<td>Normal, OK</td>
<td>The ISDN-PRI port is functioning properly.</td>
</tr>
<tr>
<td>Solid Yellow</td>
<td>PBX / Network Out of Service</td>
<td>The 9145 is receiving Remote Alarm Indication (RAI), also known as a Yellow Alarm.</td>
</tr>
<tr>
<td>Flashing Yellow</td>
<td>9145 Out of Service</td>
<td>The 9145 is transmitting Remote Alarm Indication (RAI), also known as a Yellow Alarm. Check system Active Alarms for details.</td>
</tr>
<tr>
<td>Flashing Green</td>
<td>Malfunctioning</td>
<td>ISDN-PRI Bipolar Violations or Frame Slips have occurred.</td>
</tr>
<tr>
<td>Flashing Red</td>
<td>Not Functioning</td>
<td>The 9145 is receiving an Alarm Indication Signal (AIS), also known as a Blue Alarm.</td>
</tr>
<tr>
<td>Solid Red</td>
<td>Not Functioning</td>
<td>No ISDN-PRI digital signal is being detected, Loss of Signal (LOS).</td>
</tr>
<tr>
<td>OFF</td>
<td>Not Functioning</td>
<td>Power not applied, system not functioning, or Framer IC failed self test.</td>
</tr>
</tbody>
</table>

If the indicator is **Solid Yellow** – the 9145 is receiving a Remote Alarm Indication (RAI, Yellow Alarm) from the PBX/Network over the ISDN port. This condition is normal at power up, but should not persist for more than 3 minutes. The PBX configuration settings need to be verified against the PBX configuration instructions found in the Installation section.

If the indicator is **Flashing Yellow** – the 9145 is transmitting a Remote Alarm Indication (RAI, Yellow Alarm) over the ISDN port. This condition is normal at power up, but should not persist for more than 3 minutes. Using the Administration PC, check the active system alarms window for missing files if the flashing continues. An ISDN Framing Error will also cause a Yellow Alarm to be sent; make sure that the PBX/Network line framing is configured for Extended Super Frame (ESF) operation. The PBX configuration settings need to be verified against the PBX configuration instructions found in the Installation section.

If the indicator is **Flashing Red** – the 9145 is receiving an Alarm Indication Signal (AIS); make sure that the PBX ISDN-PRI receive pair (RX) is physically connected to the 9145 ISDN-PRI transmit pair (TX). Refer to the Installation section for details.

If the indicator is **Flashing Green** – the following conditions could exist:

- Bipolar Violations (BPVs) or Excessive Zeros condition – make sure that the PBX/Network line coding is configured for Bipolar 8 Zeros Substitution (B8ZS). Electrical noise on the ISDN-PRI line can also cause this.

- ISDN-PRI Frame Slip condition – make sure that the PBX is configured for a recovered clock source (line or loop clock). Frame Slips occur when the PBX is configured for internal master clock source.

If the indicator is **Solid Red** – the 9145 is detecting a Loss of Signal (LOS) condition, make sure that the PBX/Network ISDN-PRI transmit pair (TX) is physically connected to the 9145 ISDN-PRI receive pair (RX). Refer to the Installation section for details.
If the indicator is **OFF** – verify that the Power Supply requirements and wiring as described in the Installation section have been met. If the 9145 has power applied and the indicator is still **OFF**, Contact Tone Commander Customer Service.

### 911 Call in Progress Indicator is Illuminated

Any of the 23 B Channels (voice channels) of the ISDN-PRI connection can process a 911 call. The 911 Call in Progress indicator, indicates if one or more 911 calls are in progress.

<table>
<thead>
<tr>
<th>Call Status</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OFF</strong></td>
<td>No 911 call activity (idle).</td>
</tr>
<tr>
<td><strong>Solid Yellow</strong></td>
<td>911 Call Setup is in progress, no voice connection established.</td>
</tr>
<tr>
<td><strong>Solid Green</strong></td>
<td>911 call in progress, voice connection established.</td>
</tr>
</tbody>
</table>

If the indicator is **Solid Green** or **Solid Yellow** – a 911 call is in progress; upon release/disconnect of the 911 call, the Call Status indicator should go **OFF**.

### Alarm Indicator is Illuminated

<table>
<thead>
<tr>
<th>Alarm Status</th>
<th>Meaning</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>OFF</strong></td>
<td>Normal, OK</td>
<td>No alarm condition exists.</td>
</tr>
<tr>
<td><strong>Solid Red</strong></td>
<td>Alarm Active</td>
<td>Alarm exists.</td>
</tr>
</tbody>
</table>

If the indicator is **Solid Red** – the system has an Active Alarm. The active system alarm details can be found in the Event Log viewer. Active alarms that have not cleared will be displayed, but will not have a duration time stamp. The duration time stamp field is only populated when an alarm clears.

If you connect to the 9145 Server with the Administration program, you can select **View → Real-time** to display active alarms. An example is shown below.

If the indicator is **Solid Green** or **Flashes** any color, contact Teo Technical Support.
Unable to Connect with Administration PC

If you are unable to connect to the E911 Response Server 9145 with the Administration program, double-check the settings in the Connect to Server window. The **Server Host**: can be a network name or an IP address. Make sure that the network name or IP address is correct. If you suspect the network name or IP address is incorrect, you can try pinging the network name or address and see if the device responds. If you don't get a response, check with your local IT support.

The **Port**: number by default is 5992. If this port is already in use, you may have to use another port number. If the port number must be changed, contact Teo Technical Support.

The default Username and Password are both **admin**. The **admin** account cannot be removed.

![Connect to Server window](image)

Calls Do Not Complete to 911 Call Taker

The following sections are intended to isolate 911 call processing problems. Since 911 call flow is from the PBX to the 9145 via ISDN-PRI, and then from the 9145 to the Telco Network, the first interface to verify is the ISDN-PRI connection from the PBX. Several possible problems can exist along the 911 call processing path.

- The PBX is not routing 911 Calls to the dedicated ISDN-PRI port.
- The PBX ISDN connection is not functioning correctly because of configuration problems.
- The 9145 does not recognize the call as “911” because of misconfiguration.
- The Telco Network ISDN-PRI connection is not functioning correctly.
- There is a component or circuit failure in the 911 call path.

Always verify that the 9145 is powered up and that the System Status indicator is **Flashing Green** before any troubleshooting is attempted. Verify that all 9145 front panel status indicators are showing normal or idle operation before proceeding.

Verifying Calls from the PBX

Using the Administration PC, set the **Number Dialed for Emergency**: under the **Station Info** tab to blank or no entry. Send this configuration to the 9145. This will allow any call on the
ISDN port, not just 911 calls, to be recognized and processed by the 9145 as if they were 911 calls.

Place a test call from a PBX station that should route the call to the ISDN-PRI port. Observe the front panel Call in Progress indicator to verify that it is Green, indicating the test call is being processed. This proves that the PBX is routing/sending calls to the system. If the 911 Call in Progress indicator does not illuminate Green, the PBX configuration must be modified for proper routing to the ISDN-PRI port.

After calls are routing to the 9145, verify correct call record information by retrieving the Event Log file. Set the **Number Dialed for Emergency**: to either a test number (e.g. ‘711’) or ‘911’. This will cause the system to process calls only from the test number or 911. Repeat the above test call sequence to verify that the PBX is sending the expected called number field on the ISDN-PRI port.

Verify that all 9145 front panel status indicators are indicating normal or idle operation after the test call has been disconnected. The above steps have proven that:

- The PBX is routing calls to the ISDN-PRI port.
- The PBX ISDN-PRI connection is configured correctly and functional.
- The 9145 is configured correctly and functional.

**Verifying Calls to the 911 Network**

After calls have been verified from the PBX to the 9145, the Telco Network circuits that connect to the 911 Network can be tested.

Place a test call from a PBX station that should route calls to the ISDN-PRI port. Observe the front panel 911 Call in Progress indicator to verify that it is Green, indicating the test call is being processed. This proves that the PBX is routing/sending calls to the system. The call should be sent into the 911 Network and ringback tone should be heard from the PSAP. Upon answer by the 911 Call Taker, indicate that this is a test call and ask for the display ANI.

**NOTE** – Do not hang up on the 911 Call Taker without conversing.

Using the Administration PC and Event Log viewer, verify the correct call record information including ANI by retrieving the Event Log file. If test calls from the PBX to the 9145 have been verified to be working, yet test calls do not process to the 911 call taker, the Telco Network may not be functioning correctly.

**Wrong ANI Sent to 911 Call Taker**

Whenever live 911 calls are made to the 911 Call Taker, the displayed ANI should be requested, recorded, and then verified against the station number and ANI in the Event Log. The ANI sent to the 911 Call Taker from the 9145 comes out of the Station Table data residing in the 9145.

If the ANI that is displayed to the Call Taker is not the expected or desired ANI, retrieve the Station Table data and the Event Log from the 9145. There are four causes for incorrect ANI:

1. Incorrect or no station entry in the 9145 Station Table (database).
2. Incorrect station number sent from the PBX to the 9145.
3. Incorrect interpretation of the station number by the 9145.
4. The C.O. may be masking (replacing) the ANI with a pilot number.

Determine the station number used for the call from the call record in the Event Log file. If the station number is correct, lookup this station entry under the administration **Station Info** tab and correct the E911 Calling # (ANI) field. If there is no entry under the **Station Info** tab for the station number, then the **E911 Calling Number (ANI): default number** will be used as the ANI sent to the 911 Call Taker.

If the station number is incorrect, check the calling party telephone number in the Event Log to determine if the PBX sent the correct number. This number along with **Station Number Length** under the Station Info tab is used to obtain the station number used in the database translation of ANI. The 9145 uses the Station Number Length value to extract that number of least significant digits from the calling party telephone number to determine the station number. As an example:

If the 10-digit calling party number is **4253491124** as viewed in the call record and the **Station Number Length** is set to 3, the station number will be interpreted as **124**. If the Station Number Length is set to 4, the station number will be interpreted as **1124** and so on.

Determine and correct the cause for the inaccurate station number, and then place a test call to verify that the problem has been corrected.
Troubleshooting

Reporting Devices Do Not Work

There are several types of reporting devices that are used to display 911 Call Records and/or System Alarm Records for informational and notification purposes. Each device type must be connected to the 9145 as shown in the Installation section and configured using the Administration PC Configuration file as described in the Administration section. Verify the wiring and configuration settings before proceeding.

Email Devices and Text Messaging Cellular Telephones

911 Call Alerts via Email

The 9145 is capable of sending call start, and call end messages to devices via email. Calling stations are assigned Notify Group numbers in the administration under the Station Info tab and under the E911 Notify Group column. Email addresses for email devices and email addresses for text messaging cell phones are assigned group numbers in the administration under the Notification tab and under the Notifygroup.

If station 1234 is assigned to group one under the Station Info tab, and the email address john.doe@anycompany.com is assigned to group 1 under the Notification tab, then when station 1234 dials 911, an email call start message will be sent to john.doe@anycompany.com. When station 1234 hangs up, a call complete message will be emailed. If email is being delivered to a cell phone, the email address will typically be (10digit@anycompany.com).

If the devices are not receiving emails, first try sending email to the devices with a program such as Outlook or Outlook Express to verify that the email address is valid. If you have determined that the email address is valid, then the next step is to check the email from address and email server settings defined with the 9145 administration program.

With the Administration program open and connected to the 9145 server, select File→Email Setup.

The Email Setup dialog will open.
Verify that the Email Setup entries are correct.

If you still have problems sending email alerts for calls, there may be virus scan software or a firewall blocking the email. Contact your IT support or Teo Technical Support.

**Alarm alerts via email**

Alarm set, and alarm clear messages are sent to devices listed under the administration program’s Notification tab and assigned to the ADMIN Notify Group.

If john.doe@anycOMPany.com is entered in the **Email Notify Address** column for the ADMIN Notify Group, email notification will be sent to the email address when an alarm occurs.

If the cell phone email address 8885551212@cellcompany.com is entered in the **Text Message Notify Address** column for the ADMIN Notify Group, a text message will be sent to the cell phone when an alarm occurs.

If a device is not receiving alarm alerts, first verify that the email address is correct by sending email with another program such as Outlook or Outlook Express. If you have determined the email address is valid, then the next step is to check the email from address and email server settings defined with the 9145 Administration program.

With the Administration program open and connected to the 9145 server, select **File→Email Setup**.

The Email Setup dialog will open.

Verify that the Email Setup entries are correct.

If you still have problems sending email alerts for calls, there may be virus scan software or a firewall blocking the email. Contact your IT support or Teo Technical Support.
Alert Responder Popup Screens

The E911 Response Server 9145 generates call alert and alarm alert messages to send via the LAN to PCs running the Alert Responder software. PC network names or PC IP addresses are assigned to Notify Groups with the Administration software under the Notification tab.
In the example above there are two groups, and one PC assigned to each group. 911 calls generated from stations assigned to Notify Group 1 will send popup alerts to “Laptop911-xppro”, 911 calls generated from stations assigned to Notify Group 2 will send popup alerts to IP Address “192.168.74.123”.

The easiest way to test whether a device will receive a popup alert is to use the built in test software.

With the Administration program open and connected to the 9145, select Tools, and then Test Alert Responder.

The Test the Alert Responder dialog will open.

You can select the Notify Group and send a canned call or alarm message with this test software.

If the device did not receive the test message try pinging the network name, or IP address of the PC. The name or IP address may have been entered incorrectly under the Notification tab.

The Client PCs with Alert Responder software use port 5995 by default, the E911 Response Server 9145 uses port 5996 by default. Your IT support may have to ensure that other software isn’t trying to use the same port numbers.

If you suspect that virus scan software or a firewall is interfering with delivering pop-ups, the usual procedure is to use the Windows Task Manager to momentarily shut down other programs that may be interfering.

If you isolate a program that is interfering, such as a firewall, you may have to program exceptions. Your IT tech support should be contacted first if you experience problems. You can also contact Teo Technical Support.
Specifications

Power Requirements

Voltage .................................. 100–240 VAC
Current................................... 10 A (@100 V) / 4 A (@240V) max. per outlet (2 required)

Station Capacity

100–60,000 stations, in 100 station increments (factory configured)

Ports

Recording Ports .................... 2 or 4 (factory configured)
Monitor Ports ........................ 0, 2, or 4 (factory configured)

Local Network Connections

Number of Connections ......2
Speed .................................... 10/100/1000 Mbps

Line Connections

Telco Network ....................... ISDN PRI-N
PBX ........................................ ISDN PRI-U

Physical

Dimensions ........................... 3.5" H x 19" W x 27" D (including mounting brackets)
Weight ................................... 40 lbs.

Environmental

Operating Temperature........... 32° to 104° F (0° to 40° C)
Storage Temperature ..........-4° to 185° F (-20° to 85° C)
Humidity ................................. 0 to 95%, non-condensing
Service

The Teo E911 Response Server 9145 has no user-serviceable parts inside; repair must be done by Teo.

Prior to equipment removal, call Teo Customer Technical Support for assistance in determining the source of the problem. This critical action can often prevent needless removal of equipment and subsequent customer inconvenience.

Teo Technologies
Technical Support Department
11609 49th Place West
Mukilteo, WA 98275-4255 USA

Phone: (425) 349-1000
(800) 524-0024

Fax: (425) 349-1010

E-mail: tech@teotech.com

Web: www.teotech.com

Teo is committed to meeting the product needs of our customers. Please write or call us with any suggestions for improvement.
Teo Product Warranty

For a period of one year from date of dealer purchase, but not to exceed 16 months from date of manufacture, Teo Technologies (Teo) warrants its products to be free from defects in material and workmanship under conditions of normal use and service. Teo shall, at its option, repair or replace any defective product which, in its opinion, has not been misused, damaged, or improperly installed.

Repair or replacement under this warranty will be performed at Teo's factory. Authorization must be obtained from Teo prior to returning a product for repair. Freight must be prepaid for all units returned to Teo. Units repaired under warranty will be shipped UPS Ground (or equivalent), freight prepaid by Teo.

Products that are older than the warranty period, but less than 7 years old, or still manufactured by Teo may be repaired at the factory for a flat rate charge. Repaired out-of-warranty units are warranted for 90 days from the date of repair.

The repair or replacement of a product under this warranty represents the entire obligation of Teo; Teo shall not be liable for any special or consequential damages resulting from or caused by any defect, failure, incapacity or malfunction of any of its products.

_The foregoing express warranty is in lieu of all other warranties, express or implied, including but not limited to any implied warranty of merchantability, fitness, or adequacy for any purpose or use, quality, productiveness or capacity; Teo, to the extent permitted by law, hereby disclaims all such other warranties._

_The foregoing express warranty is in lieu of all other warranties, express or implied, including but not limited to any implied warranty of merchantability, fitness, or adequacy for any purpose or use, quality, productiveness or capacity; Tone Commander, to the extent permitted by law, hereby disclaims all such other warranties._
Safety and Regulatory Requirements

Cautions

- Power wiring must be 18 AWG or larger.
- Do NOT attach or staple any Power Wiring to any building surface.
- Risk of electrical shock! Disconnect power before opening unit.
- At no time during connecting or routing of cables should power be applied to the equipment.
- Use caution when installing or modifying telephone wiring.
- Never touch uninsulated telephone wiring unless it is disconnected at the network interface.
- Never install telephone jacks in wet locations unless jack is designed for wet locations.
- Do not use solvents or liquids to remove dust or dirt from the 9145.

FCC Part 15

This equipment has been tested and found to comply with the limits for a class A digital device, pursuant to the Part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This unit generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense. Changes or modifications not expressly approved by the party responsible for compliance could void the user’s authority to operate the equipment.
FCC Part 68

This unit is registered with the FCC and complies with the part 68 of the FCC regulations. The following information is provided as part of that compliance.

On the rear panel of this unit is a label that contains the FCC registration number and the ringer equivalence number (REN) for this equipment. You must, upon request, furnish this information to your telephone company.

This unit must be installed by telephone installation personnel.

If this unit is installed and trouble occurs, it must be disconnected, and reinstalled only after the problem has been corrected.

If this unit appears to be causing a problem with the telephone network and it is not removed, the Telephone Company may discontinue service temporarily. If possible they will give advance notice. However, if advance notice is not practical, notifications will be made as soon as possible. The Telephone Company will allow time to correct the situation. They will also provide information on your rights to file a complaint with the FCC.

The Telephone Company may make changes to its equipment or procedures that could affect the proper functioning of this unit. If they do, you will be notified in advance to give you an opportunity to maintain uninterrupted service.

Repair work on this unit must be done by the manufacturer, Teo Technologies.

When installing this unit, and ordering ISDN-PRI circuit facilities with AMI line coding from the Telephone Company specify:

- Service Order Code: **6.0Y**
- Facility Interface Code: **04DU9.1KN**
- USOC Jack No.: **RJ48C**

When installing this unit, and ordering ISDN-PRI circuit facilities with B8ZS line coding from the Telephone Company specify:

- Service Order Code: **6.0Y**
- Facility Interface Code: **04DU9.1SN**
- USOC JACK No.: **RJ48C**

Additional Information that may be required:

- FCC Reg. No.: US: **{pending}**

National Electrical Code

This equipment shall be installed only in restricted access areas in accordance with Article 800 of the National Electrical Code ANSI/NFPA No. 70 1999 and any local codes as required. All external wiring should follow current National Electrical Code requirements.
**Glossary**

**ALI** (Automatic Location Information) – This is the location information of the 911 caller as viewed by the 911 Call Taker. This information includes the 911 Caller’s name, address and other relevant data associated with the caller’s telephone number. This information resides in a Telco database that is accessed by the 911 Call Taker telephone equipment.

**AMI** (Alternate Mark Inversion) – An Integrated Services Digital Network (ISDN) port configuration setting that dictates the line coding format of the ISDN port. This line-coding scheme allows eight or more digital zeros to be transmitted consecutively over the ISDN connection. AMI line coding on an ISDN connection is rarely ever used and has been replaced by the Bipolar 8 Zero Substitution (B8ZS) digital line-coding scheme.

**ANI** (Automatic Number Identification) – This is the telephone number of the 911 caller as viewed by the 911 Call Taker. It can be thought of as the Caller ID number in the 911 network. ANI(s) or telephone numbers are assigned by and purchased from the Telephone Company (Telco).

**B8ZS** (Bipolar 8 Zero Substitution) – An Integrated Services Digital Network (ISDN) port configuration setting that dictates the line coding format of the ISDN port. This line-coding scheme does not allow eight or more digital zeros to be transmitted consecutively over the ISDN connection. Virtually all ISDN ports use this line-coding scheme.

**E911** (Enhanced 911) – Refers to 911 network and Call Taker services that enable the 911 Call Taker to obtain and view the caller’s telephone number (ANI). This telephone number must be transmitted through the 911 network in order to provide E911 services such as the display of ANI and ALI.

**ESF** (Extended Super Frame) – An Integrated Services Digital Network (ISDN) port configuration setting that dictates the line framing format of the ISDN port. This frame format allows alarm and maintenance information to be transmitted over the ISDN port connection. Nearly all ISDN-PRI ports use this frame format.

**ISDN D (Data) Channel** – An Integrated Services Digital Network (ISDN) port channel (time slot) that carries the basic call control packet information for the other 23 voice channels contained in the 1.544 Mbit digital data stream. The D channel is typically assigned to channel number 24 on the ISDN-PRI port.

**ISDN-PRI** (Integrated Services Digital Network - Primary Rate Interface) – A telephone industry standard that provides for 23 voice/data channels with a D channel to control them. Typically used in business voice communications to connect PBXs to the Telephone Company (Telco) when many voice circuits are required.

**Local Notification** – Refers to the reporting/notifying capabilities of the Teo E911 Response Server 9145 when it is physically connected to a reporting device. Local reporting devices include serial printers that are directly wired to the 9145. 911 call activity and system alarm messages are sent to these devices for alerting and response purposes.

**LBO** (Line Build Out) – An ISDN-PRI port configuration setting that controls the amplitude (voltage level) of the digital signal transmitted on the TX signal leads. A level of 0.0 dB is typically selected which provides for the highest amplitude digital signal allowed.
PSAP (Public Safety Answering Point) – The physical location where the 911 Call Takers answer calls and provide emergency services operations. Emergency calls and the associated 911 network circuitry terminate or end at the PSAP location.

Remote Notification – Refers to the reporting/notifying capabilities of the Teo E911 Response Server 9145 when it is programmed to make a connection to a routable network reporting device. Remote reporting devices include Local Area Networks (LAN) displays, alpha pagers and serial printers with modems attached. 911 call activity and system alarm messages are sent to these devices for alerting and response purposes.

Station Table – The database created or imported on a Personal Computer (PC) using the Administration program that contains the PBX number to ANI translations. This is sent to the system and is used in 911 call processing to translate PBX station numbers (extensions) to ANI(s) for use in the 911 network. The Station Table also contains the user-entered inside location and directions for each PBX station number.